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Einführung 
 
 
 
Willkommen zu Flame Painter!  
 
Flame is ein Malprogramm, mit welchem Sie originale Kunstwerke, Lichteffekte, 
unkonventionelles Design oder phantastische Hintergründe mit Flamme Bürsten ganz einfach 
kreieren können. 
Es wurde als ein Experimentierprojekt in meiner Serie "I am an Artist" entwickelt. Meine erste 
Version sollte ein Programm sein wo jeder etwas Schönes gestalten konnte. Flame sollte ein 
Werkzeug sowohl für den Künstler als auch für Leute ohne künstlerisches Talent sein, die was 
Einzigartiges gestalten wollen.  
 
Der Mangel an Inspiration ist oft der Grund warum Menschen nicht kreativ sind, jedoch können 
die Werkzeuge die wir nutzen eine Quelle der Inspiration sein. Mit jedem Werkzeug, das einen 
inspiriert, kann jeder zum Künstler werden. Darum wurde Flame Painter geboren!  
 
Diese Bedienungsanleitung behandelt die Features des Programms und erläutert, was man 
alles wissen muss, um mit Flame Painter malen zu können. Es gibt eine schöne Auswahl an 
Pinselparameter ‐ experimentieren Sie mit unterschiedlichen Pinseleinstellungen und vielleicht 
finden Sie einen neuen kreativen Weg der Selbstdarstellung!  
 
Danke, dass Sie Flame Painter erworben haben. Ich hoffe Sie haben viel Spaß mit dem Malen! 
 
                Peter Blaškovič 
         Entwickler von Flame Painter 

  



Benutzeroberfläche 
 

 

Werkzeuge 
 
 
Brush / Pinsel – Wählt den Pinsel aus 
Eraser / Radiergummi – Wählt das Radiergummi aus 
Fill / Füllen – Wählt das Füllwerkzeug aus 
Zoom In / Einzoomen – in das Bild reinzoomen (bis 
200%) 
Zoom Out / Rauszoomen – aus dem Bild 
herauszoomen (bis 5%) 
Reset Zoom / Zoomfaktor zurücksetzen – Bitte 
Zoomwert überprüfen. Beim Click auf diesem Button 
wird auf 100% gezoomt. 
Undo / Rückgängig – Letzten Schritt rückgängig 
machen 
Redo / Wiederholen – Zürückgenommene 
Bildänderung wiederholen 
 
 

Brush / Pinsel 
 
Es stehen drei Malmodi zur Verfügung: 
 
Flame – Der klassische “Flame” Malmodus 
Follow / Verfolgen – Der Pinselstrich verfolgt den 
Mauszeiger genauer 
Ribbon – Der Malmodus “Schleife” 
 
Blending / Füllmethode – Farbfüllmethode. Es stehen 
drei Farbfüllmethoden zur Verfügung - Normal für das 
Standardmalen, Lighten / Aufhellen (additiver Modus) 

wird typpischerweise für Lichteffekte auf dunkle Hintergründe und Darken / Abdunkeln 
(subtraktiver Modus) für lichteffekte auf hellen Hintergrundfarben. 
 
          Opacity / Deckkraft – Pinseldeckkraft (0 - 100) 
 
 
Pinselparameter Flame, Follow und Ribbon  
 
Mit folgenden Pinselparametern können Sie experimentieren: 
 
Size / Größe - Pinseldurchmesser (1 – 300) 
Span - Pinselbreite (0 – 10) 



Dist – Pinselpunktabstand (1 – 20) – wählbar, wenn "Lines" mit "On"aktiviert ist 
 
Soft / Härte – Pinselhärte (1 – 100) 
Speed / Geschwindigkeit – Pinselgeschwindigkeit (1 – 100) 
Center / Stärke – Globale Kräfte (0 - 100) 
Focus / Fokus  - Lokale Kräfte (0 – 100) 
Chaos – Chaos-Parameter (0 – 100) 
Noise / Rauschen – Rausch-Parameter (0-100) 
 
Fade / Blenden – Ein- und Ausblenden (0-10). Einstellen des Blendzeitpunktes 
 
Fill | Lines / Füllung | Linien – Wechsel zwischen den Modi "Fill" und "Lines" 
 
Detail - Pinselstrichdetail (1-4). Stellt die Details des Flammenpinselstrichs ein. Ein höherer 
Wert kann wegen der Rechenintensität zu einer Verlangsamung des Programms führen. 
Höhere Werte sind gut für weiche Pinselbewegungen oder wenn das Bild sehr groß ist.  
 
Antialiasing (AA) – Wechsel zwischen "Normal Antialiasing" (Normales Antialiasing) und 
"Supersmooth Antialiasing" (superweiches Antialiasing) 
Bem.: Der Parameter "Supersmooth Antialiasing" kann wegen höherer Rechenintensität zu 
einer Verlangsamung des Programms führen.  
 
 

 

Eraser / Radiergummi 
 
Parameter: 
 
Size / Größe – Größe des Radiergummis(1-200) 
Hardness / Härte – Härte des Radiergummis (0-100) 
Step / Schritt – Schritt des Radiergummis (0-100) 
Opacity / Deckkraft – Deckkraft des Radiergummis (0-
100) 

 
 

 
 
 

Fill / Füllwerkzeug 
 
Man kann die Ebene mit "Color" (Farbe) oder 
"Gradient" (Farbverlauf) füllen. Beim Farbverlauf kann 
man die vertikale oder horizontale Orientierung 
einstellen. 
 
Vertical |Horizontal – Wechsel zwischen "Vertical" und 
"Horizontal" Farbverlaufsfüllung 



Farbfenster 
 
 
Color | Gradient – Auswahl der Füllmethode. Eine Farbe oder mit einem Farbverlauf. 
 
 

Color / Farbe 
 
Pinselfarbe auswählen. 
 
H – Farbton (0 - 359) 
S – Farbsättigung (0 - 255) 
L – Helligkeit (0 - 255) 
 
Palette – Farbe auswählen 
 
(+) (-) – Farbfeld hinzufügen oder entfernen. 
 
Ein einzelner Mausklick auf einem Farbfeld öffnet die 
Farbauswahlpalette. 
Die Farbe könnte in den Modi Aufhellen (Lighten) oder 
Abdunkeln (Darken) sich von der Pinselfarbe 
unterscheiden! Besteht der Wunsch nach der exakt 
gleichen Farbe, sollte der Malmodus Normal ausgewählt 
werden. 

 
 

Gradient / Farbverlauf 
 

Wählen sie einen Farbverlauf und klicken Sie  auf die zu 
ändernde Farbe unterhalb des Farbverlaufs. Einzelne 
Farben des Verlaufs können ein- bzw. ausgeschaltet 
werden. 
 
Rotate – Farbverlauf drehen 
Flip – Verlaufsübergang spiegeln 
 
H | S | L – ändert Farbton, Sättigung und Helligkeit aller 
Farben im Verlauf. 
 
Length / Farbverlaufslänge – Wählen Sie, ob Sie den 
Farbverlauf an die Pinselbreite anpassen oder die Länge 
des Farbeverlaufs verändern möchten. 
 
(+) (-) – Farbfelder oder Farbverläufe hinzufügen bzw. 
entfernen. 



Brushes Panel / Pinselvoreinstellungen 
 

Die Palette enthält Pinselvoreinstellungen. Ein 
Abspeichern neuer Voreinstellungen ist möglich. 
 
Use brush palette – aktivierte Voreinstellung aktivieren 
 
(+) (-) – Hinzufügen oder Entfernen von 
Pinselvoreinstellungen. 
 
Eine neue Pinselvoreinstellung wird durch das 
anklicken des (+)  abgespeichert. Das Icon selbst wird 
bemalt. Das Abspeichern erfolgt nach der Eingabe des 
Namens der Pinselvoreinstellung. Diese wird in der 
Palette sofort sichtbar. 
 
Es ist möglich die neuen Pinseln direkt aus der Brushes 
Webseite nach Flame Painter ziehen und ablegen (Drag 
& Drop Funktion). Link auf die kostenlosen Pinseln: 
http://www.escapemotions.com/products/flamepainter/bru
shes/index.php 

 
 

Layers Panel / Ebenenfenster 
 

Man kann mehrere Ebenen übereinanderpositionieren. 
 
New Layer – Neue Ebene hinzufügen. 
New Vector Layer – Neue bearbeitbare Vektorebene 
hinzufügen. Diese Option steht nur in der Pro Version 
zur Verfügung! (Im folgenden Kapitel mehr über 
Vektorebenen) 
Duplicate Layer – Aktive Ebene(n) duplizieren. 
Merge Layers – Mehrere Ebenen auf eine Ebene 
reduzieren. 
Remove Layer – Aktive Ebene(n) löschen. 
 
Clear Layer – Ebeneninhalt leeren. 
 
In der Menüleiste, es ist möglich die Vektorebene zu 
Bitmap konvertieren. 
 
Blending - Ebenenmodus. 
Opacity – Deckkraft der Ebene (0-100%) 
Eye / Augenicon – Ebene sichtbar oder unsichtbar 
machen. 

http://www.escapemotions.com/products/flamepainter/brushes/index.php
http://www.escapemotions.com/products/flamepainter/brushes/index.php


 

Editable Vector Layers / Bearbeitbare Vektorebenen - Pro 
version 

 
Vektorebenen besitzen den Vorteil, dass man sie 
bearbeiten kann. In der Vektorebene kann man einen 
Pinselstrich malen und anpassen. Nach dem 
Pinselstrich kann man jeden Pinselparameter, 
Verlaufsmodus, Deckkraft, Farbe, Farbverläufe 
nachträglich verändern. Es ist ebenso möglich, andere 
Pinselvoreinstellungen zuweisen. 
 
Paint Tool / Malwerkzeug – Neuer Pinselstrich. In 
Vektorebenen nehmen nur einen Pinselstrich auf. 
Edit Tool / Bearbeitungswerkzeug - 
Schlüsselknotenpunkte bearbeiten (gelbe Punkte), um 
den Vektor zu mofidizieren. Auf die grauen 
Knotenpunkte klicken, um sie zu 
Schlüsselknotenpunkten (gelb) zu verändern. 
Group Edit Tool / Gruppenbearbeitungswerkzeug – 
Mehrere Schlüsselknotepunkte bearbeiten (gelbe 
Punkte). 
Add & Remove Tool / Hinzufügen und Entfernen - 
(Tastenkürzel: STRG) Bearbeitbare Knotepunkte aus 
der Flammenlinie entfernen. 
Curve Transform / Kurvenbearbeitung – Größe, 
Drehung und Skalierung des Pinselstrichs anpassen.  
Init Curve Transform / Anfangskurve anpassen – 
Größe, Drehungs und Skalierung der Anfangskurve des 
Pinselstrichs anpassen. 
 

 
  



Die Menüleiste 

 
File / Datei - enthält Elemente im Zusammenhang mit Laden, Speichern, Exportieren und 
Veröffentlichen Ihrer Bilder. 
Tools / Werkzeuge - enthält Elemente im Zusammenhang mit den Malwerkzeuge und die 
Leinwand 
Layer / Ebenen - enthält Elemente im Zusammenhang mit den Ebenen 
View / Ansicht - enthält Elemente im Zusammenhang mit den Ansichtsfenster und 
Benutzeroberfläche. 
Help / Hilfe - enthält Elemente mit welchen Sie die Anwendungshilfe bekommen, neue 
Updates auf die Webseite. 
 
 

File Menu (Datei) 
 
New... / Neu… - Erzeugt ein neues Bild mit neuen Einstellungen. 
Open... / Öffnen…  - Öffnet ein gespeichertes Bild. 
Save... / Speichern… - Speichert das aktuelle Bild. Wurde das Bild noch nicht gespeichert, wird 
nach einem neuen Namen gefragt. 
Save As… / Speichern unter… - Speichert das aktuelle Bild mit einem neuen Dateinamen. 
 
Import… / Importieren… - Öffnet ein Bild als neue Ebene. Das Bild wird entsprechend der 
aktuellen Bildgröße skaliert. 
 
Publish… / Veröffentlichen – Veröffentlicht das Bild auf der Flame Painter Galerie im Internet. 
Ein Fensterdialog fragt nach dem Namen des Bildes mit der optionalen Angabe einer 
Beschreibung und Stichwörter.  
 
Quit / Beenden – Flame Painter schließen. 
  
Siehe auch Kapitel „Erzeugen, Öffnen und Speichern von Bildern“. 
 
 

Tools Menu / Werkzeuge 
 
Brush / Pinsel – Pinsel auswählen. 
Eraser / Radiergummi – Radiergummi auswählen. 
Fill / Füllen – Füllwerkzeug auswählen. 
 
Undo / Rückgängig – Letzten Schritt rückgängig machen. Die maximale Anzahl an Rückgängig-
Schritten beträgt entweder 100 oder je nach Speichergröße des Computers. 
Redo / Wiederholen – Letzten Schritt wiederholen. 
 
Show Cursor / Mauszeiger zeigen 
Show Brush Dots / Pinselpunkte anzeigen 



 

Layer Menu / Ebene 
 
New Layer / Neue Ebene – Neue Ebene hinzufügen. 
New Vector Layer / Neue Vektorebene – Neue Vektorebene hinzufügen 
Duplicate Layer / Ebene duplizieren – Aktive Ebene(n) duplizieren 
Merge Layers / Ebenen reduzieren – Ebenen in eine Ebene reduzieren 
Delete Layer / Ebene löschen – Aktive Ebene(n) löschen 
 
Hide Layer / Ebene verstecken – Aktive Ebene verstecken oder zeigen 
 
Tile Layer / Kachelebene – Kachelt die Ebene (horizontal und vertikal) 
 
Clear Layer / Ebene leeren – Ebeneninhalt leeren 
Convert to bitmap / Zu bitmap konvertieren – Vektorebene zu Bitmapebene konvertieren (nur 
Pro Edition). 
 
 

View Menu / Ansicht 
 
Zoom In / Einzoomen - in das Bild reinzoomen (bis 200%). 
Zoom Out / Rauszoomen - aus dem Bild herauszoomen (bis 5%) 
Zoom 100% - Bitte Zoomwert überprüfen. Beim Click auf diesem Button wird auf 100% 
gezoomt 
 
Stay on Top / Bleib auf der Spitze– Die Applikation bleibt immer auf der Spitze der anderen 
Applikationen. 
Fullscreen – stellt auf volle Bildschirmgröße um (klick Esc zu schließen) 
Presentation mode / Presentationmalmodus - Full screen Malmodus ohne Menüleiste (klick 
Esc zu schließen) 
 
 

Help Menu / Hilfe 
 
Help / Hilfe – Öffnet dieses Dokument (in Englisch) 
Flame Painter Website - Link auf die Webseite: 
www.escapemotions.com/products/flamepainter 
About Flame Painter – Weitere Informationen über Flame Painter, Copyright und 
Danksagungen. 
 
Publish Preferences... / Voreinstellungen veröffentlichen – Ein Untermenü mit Galerie-
Voreinstellungen. 
 
Show Brushes Folder / Brushes Ordner zeigen – Den Ordner zeigen wo die Pinseln gespeichert 
sind. 
  



Erzeugen, Öffnen und Speichern von Bildern 
 
 

Ein neues Bild erzeugen 

 
Mit STRG+N oder über den Menüpunkt File -> New… wird ein neues Bild zu erzeugt. Ein 
Dialogfenster erscheint, in welchem man die Bildgröße und weitere Einstellungen angeben 
kann. “Picture Size Info” gibt die Druckgröße des Bildes an. 
 
Mit dem Farbbutton Color kann man die Hintergrundfarbe auswählen.  
 
Bestätigen Sie die Eingaben mit OK oder verwerfen diese mit Cancel. 
 
 

Ein Bild öffnen 

 
Mit STRG+O oder über den Menüpunkt File -> Open... öffnet man ein bestehendes Bild in 
Flame Painter. Zusätzlich können die Eigenschaften des Bildes angepasst werden.  
 
Öffnen Sie das Bild mit OK oder brechen Sie mit Cancel ab. 
 
Sie können das Bild direkt aus einer beliebigen Quelle ziehen und ablegen (Drag and Drop 
Funktion) – Es kann Ordner, Browser oder Website sein. Es öffnet sich als eine neue Ebene.  
 
 

Ein Bild speichern 

 
Über die Menüpunkte File -> Save... und File -> Save As… speichert man das Bild auf die 
Festplatte. Flame Painter nutzt ein eigenes Dateiformat mit der Endung FPA. In der Datei sind 
alle Informationen des Bildes und der Ebenen enthalten. Nutzen Sie dieses Dateiformat, wenn 
Sie später an einem bestehenden Bild weiter arbeiten möchten. 
  
Weitere Dateiformate stehen zur Verfügung, jedoch werden Detailinformationen nicht mit 
abgespeichert. Achten Sie darauf, dass sich die Hintergrundfarbe eventuell ändern könnte. 
Beispielsweise werden Transparenzinformationen nicht im JPEG-Format abgespeichert.  
 
Wenn das Bild mit spezifischen Einstellungen oder für andere Programme lesbar abgespeichert 
werden sollen, nutzen Sie die Save Funktion über den Menüpunkt. Das Bild lässt sich in den 
Formaten PNG, TGA, TIF, BMP oder JPG abspeichern.  
 
Speichern Sie das Bild mit OK oder brechen Sie mit Cancel ab. 
  



Veröffentlichen eigener Werke in der Online-
Galerie 

 
 

Galerie-Konto erzeugen 
 
Um eigene Werke zu veröffentlichen, ist ein eigenes Konto erforderlich. Anbei die 
Beschreibung zweier Vorgehensweisen:  
 
Aus Flame Painter heraus: 
Konto über den Menüpunkt Help->Publish Preferences erzeugen. Geben Sie Ihren Namen, E-
Mail (“Your ID”) und Passwort ein. Optional ist die Angabe der eigenen Webseite. 
 
Auf der Webseite: 
Auf der Flame Painter Gallery Webseite loggen Sie sich über login -> Create Account ein und 
geben Ihre “Your ID” (Ihre Registrierungs-E-Mail) an. Sie erhalten per E-Mail ein Passwort 
zugeschickt. 
Bem.: "Your ID" wird im Programmmenü Help->About Flame Painter angezeigt. Sollte "Your ID" 
nicht existieren, geben Sie Ihre aktuelle E-Mail-Adresse ein. 
 
 

Veröffentlichen eigener Werke 
 
Um ein eigenes Werk in der Galerie zu veröffentlichen, nutzen Sie den Menüpunkt File -> 
Publish... Geben Sie Ihrem Werk einen Namen (Artwork Name), eine Bechreibung (Description) 
und Stichwörter (Tags). Durch das Klicken des Publish Buttons wird Ihr Bild auf der Flame 
Painter Gallery Webseite (www.escapemotions.com/gallery) veröffentlicht. Die Bilder dort 
können auch nachträglich weiter bearbeitet warden. 
 
 

Galerieprofil und Bilder bearbeiten 
 
Gehen Sie auf die Gallery website, loggen Sie sich über login ein und geben "Your ID" und 
Password an. 
Im Bereich Edit Pictures können u.a. Namen, Beschreibungen und Stichwörter bearbeitet 
werden. 
Im Bereich My Profile kann das Passwort geändert warden. 
 

  

http://www.escapemotions.com/gallery


Tastenkürzel: 
 
New... / Neu...  STRG+N 
Open.../ Öffnen...  STRG+O 
Save / Speichern  STRG+S 
Save As... / Speichern unter...  STRG+Shift-S 
Publish... / Veröffentlichen...  STRG+P 
Quit / Beenden  STRG+Q 
 
Undo / Rückgängig  STRG+Z 
Redo / Wiederholen  STRG+Shift+Z 
 
Brush / Pinsel  Q 
Eraser / Radiergummi  E 
Fill / Füllwerkzeug  F 
 
Increase Value +1 / Wert um 1 vergrößern  Pfeil nach oben 
Decrease Value -1 / Wert um 1 verringern  Pfeil nach unten 
 
Increase Value +10 / Wert um 10 vergrößern  Bild auf 
Decrease Value -10 / Wert um 10 verringen  Bild ab 
 
Cursor Show | Hide – Mauszeiger zeigen/verstecken  Alt-C 
Brush Dots Show | Hide – Pinselpunkte zeigen/verstecken Alt-D 
 
Clean Layer / Ebene löschen  Del 
 
Move a Canvas / Canvas bewegen  Rechte Maustaste oder  
  Leertaste+ Linke Maustaste 
 
Zoom In / Reinzoomen  STRG + 
Zoom Out / Rauszoomen  STRG - 
Zoom 100%  STRG 0 
Zoom In | Out – Rein-/Rauszoomen  Alt + Mausrad 
 
Help / Hilfe  F1 
 
 
Professional-Version: 
 
Paint Tool / Malwerkzeug  1 
Edit Tool / Bearbeitenwerkzeug  2 
Group Edit Tool / Gruppenbearbeitung  3 
Add & Remove Tool / Hinzufügen und Entfernwerkzeug 4 
Curve Transform / Kurvenbearbeitung  5 
Init Curve Transform / Anfangskurve anpassen  6  



Personal versus Professional Version 
 
 
Personal Version eignet sich für die Nutzer, die eine vollständige Version haben möchten und 
auf die Vektorebenen verzichten können. Zusätzlich ist es den Benutzern dieser Version nicht 
erlaubt, Bilder zu verkaufen, die mit Flame Painter bearbeitet oder erzeugt wurden. Diese 
Lizenz erlaubt die Installation von Flame Painter auf mehrere Rechner eines Benutzers und die 
Nutzung des Programms für nichtkommerzielle Zwecke. 
 
Professional Version ist für die fortgeschrittenen Benutzer gedacht, die mit Vektorebenen 
arbeiten möchten. Die Proversion bietet zusätzlich keine Einschränkung in der maximalen 
Anzahl an Ebenen und die Option „Supersmooth Antialiasing“. Diese Lizenz erlaubt die 
Installation von Flame Painter auf einem einzigen Rechner und kann für kommerzielle Zwecke 
genutzt werden. 
 
Weitere Details finden Sie in der vollständigen “Software License Agreement“ in Englischer 
Sprache. 
 
 

  



Copyright & Danksagungen 
 
 
Flame Painter © 2012-2013 Escape Motions, s.r.o 
Flame Painter © 2009-2012 Peter Blaškovič 
 
 

Flame Painter Team: 
 
Peter Blaškovič, Jozef Bardík, Rastislav Hornák, Michal Fapšo, Rastislav Piovarči, Veronika 
Klimeková, Andrea Vachová 
 
 

Unser besonderer Dank geht an: 
 
alle, die mit Ideen, Anregungen beigetragen, oder Flamme Painter finalisieren geholfen, 
insbesondere Gabika Ambrušová, Cara, Daniel Innes, Tanya Hayman, Oto Kona, Tomáš Lancz, 
Lukáš Lancz, Tony Lloyd, Tomáš Mišura, Andrei Oprinca, Martin Surovček, Daniel Streidt, 
Roman Urbášek. 
 
User Interface Icons / Benutzeroberfläche Ikonen: "Batch" by Adam Whitcroft 
 
 

Libraries / Bibliotheken: 
 
Diese Applikation ist mit den folgenden Bibliotheken entwickelt worden: 
Qt 4.8 - LGPL license (2.1) - http://qt-project.org/downloads/ 
QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/ 
CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/ 
 
 
Gott sei Dank für alle kreativen Ideen. 
 
 
 

http://qt-project.org/downloads
http://sourceforge.net/projects/quazip/
http://www.cryptopp.com/

